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Section 1.  Using SIFT to Examine a Single AHI Band 
 
1a) NOAA has funded the creation of a tool specifically designed to display and interrogate 
Geostationary Meteorological Satellite data: the Satellite Information Familiarization Tool 
(SIFT).  To launch this tool, select the Run SIFT icon on your laptop Desktop.   Two windows 
will open, a terminal window recording runtime python output, and the SIFT active display 
window.   Change the projection from the default (LCC (CONUS)) to Mercator for the first part 
of this lab. 
 

 
 
Figure 1:  SIFT Display Window at start up.  The default projection is LCC over CONUS. 

 
Load an AHI Level 1B file from disk: select File->Open from the top level tool navigation (or 
type “ctrl-O”).  On the computer’s Windows7_OS(C:) drive (or the equivalent file on disk in a 
linux machine), find /data/ahi/Introduction/20150717_2100_20150718_2000_60, select 
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the .merc (NOT .nc) file  HS_H08_20150717_2100_B01_FLDK_R20.merc and choose Open 
in the bottom right corner.  This file should be the first in the sequence.  You may find it easier 
to view the files in the selector as “list” or “details” than as icons (see Figure 2 below). 
 

 
Figure 2: Example of choosing an AHI data file for display in SIFT. 
 
When the file is loaded, AHI Band 1 (.47 μm) reflectances from 17 July 2015, 21:00 UTC will 
appear in the display window (Figure 3). 
 

 
Figure 3:  AHI Band 1 (.47 μm) sub-sampled image over the Western Pacific displayed in 
SIFT. 
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The date and time of the displayed image is listed below the image window.  More details 
about the current display is shown in the lower right section of the SIFT window, including the 
instrument name, central wavelength, and the current color map applied to enhance the data.   
You can resize the SIFT window by dragging a window boundary or even display in full 
screen mode by double clicking on the SIFT top window banner. 
 
Zoom in on a section of data by rolling the scroll wheel while in the image display.  The 
image will resize to fit the display window with increasing spatial resolution.  Move around in 
the display by Left Click+drag.   
 
Cycle through the map display options by typing the “B” key (for ‘borders’, lower or upper 
case) while in the SIFT image window.  Do the same with Latitude/Longitude options using 
the “L” (for ‘lat/lon’ lower or upper case) key.  Determine which options you prefer.  These 
options can also be chosen under the ‘View’ tab in the upper left part of the SIFT window. 
 
Now zoom in to view the area in and around Guam as shown in Figure 4. 
 

 
 
Figure 4:  AHI Band 1 (.47 μm) full resolution image in and around Guam. 
 
1b)  Probe the values in the scene by Right Clicking in the image window.  The reflectance 
values along with the pixel latitude/longitude will appear at the top of the image window.   
Answer the questions in the box.  
 
 What/where are the highest and lowest reflectance values that you find in this scene? 
 What are the most common reflectance values?   
 What type of clouds dominate this scene?  
 If the maximum reflectance value is about 1.0, why are reflectance values so low?    
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Remove the current image from the display by highlighting the AHI B01 Refl data set in the 
Layers panel in the right column and then selecting Edit->Remove Layer from the top level 
navigation bar (or by hitting the ‘Delete’ key).  Note that the Probe will remain in the image 
window. 
 
Section 2.  Using the SIFT Tool to Examine Multiple AHI Bands 
   
2a) Load in all 16 AHI bands from the 18 July 2015 Himawari-8 AHI dataset observed at 2:30 
UTC found at /data/ahi/Introduction/20150718_0100_20150718_0320_10.  You can choose 
more than one file at a time by Ctrl+Left Click on each individual band, or a consecutive 
sequence of files by selecting the first file and then Shift+Left Click on the last file in the 
sequence (see result in Figure 5).  The display will appear as shown in Figure 6.   
 

 
Figure 5:  AHI highlighted files used for Section 2 tasks.  All 16 bands from 18 July 2015, 
02:30 UTC will be used. 
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Figure 6:  SIFT tool display of 16 bands of AHI data observed on 18 July 2015 at 02:30 UTC. 
 
2b) Probe the data again from Band 1.  Answer the questions in the box. 
 
How do the values compare from the previous data/time that we investigated?   
Why are the values so much different?   
 
As you move the probe around, note how the reflectance/brightness temperature values in 
the “Layers” window change for each band.  The length of the color bar in the Layers window 
for each band provides an indication of the intensity of the value for that point based upon the 
typical range of values.  You can separate the “Layers” sub-region by Left Click+drag on the 
sub-window banner (or by double-clicking on it).  Once it is independent, you can easily resize 
it.  An example of a re-sized independent Layer window, external to the SIFT window is 
shown in Figure 7.   
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Figure 7:  Screen capture of the SIFT Layers window separated from the main display 
window.   The example is from the AHI 18 July 2015 data set.    
 
You should at some point be able to identify the type of scene simply using probe output.  
This particular example is highly reflective in visible and in the 0.86 µm, but not so reflective in 
the 1.6 µm  and 2.2 µm bands, and the IR channels are uniformly cold (except for the 
shortwave IR, Band 7 at 3.9 µm)  This is likely thick cirrus. 
 
2c) To loop the bands, select the ► from the animation controls below the image window.  
Right click on the ► button to launch the loop control tool slider, and adjust the speed by 
moving the bar up or down.  Stop by the loop by clicking ► again.  Step through the bands by 
using the up and down arrows on your keyboard.  Note that the Infrared bands on the AHI 
have color enhancement displays.  What advantage does a color enhancement provide over 
grayscale for these particular bands? 
 
2d) Zoom out to display the entire image at reduced resolution.  Step through the bands.  As 
you are stepping through, note which bands see the surface and which do not.  Answer the 
questions in the box 
 
What band displays the warmest temperatures (use the Probe to help you)?    
Where are they located?  
Where are the coldest temperatures found?    
How do the infrared band temperatures compare for these cold regions?   
Why are the temperatures different?    
What are reflectances like in the visible band for these cold clouds?   
Why are the reflectances different? 
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Section 3.  Using AHI to Identify Aerosols 
 
3a) Now let’s examine different regions more closely (See Figure 8).  Let us start by looking at 
the boxed area over Siberia.  Zoom into that region to display it at full resolution.  Starting with 
Band 1 (.47 μm), how do the reflectances compare in visible bands (AHI bands 1-6) over the 
main bright hazy feature going from West to East in the image?   
 
Which visible reflectance band has the highest reflectances in this region?   
With which visible reflectance bands can you discern this feature? 
Can you see this feature in the infrared bands (AHI bands 7 – 16)?   
 
 
3b)  Because dust/aerosols are usually composed of very small particles, they scatter energy 
the most at smaller wavelengths.   
 
How could you use this information and AHI bands 1 (.47 μm) and band 5 (1.6 μm) 
reflectances to help you quickly discern whether a scene contains dust and/or aerosols? 
 
 
 
3c)  Why is the Band 1 (.47 μm) image generally hazier than Bands 2 (.51 μm) and 3  
(.64 μm)?   
Which of these three bands provides the most detail in the image?  Why? 
 

Figure 8:  Three regions of interest for study. 
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Section 4.  Discriminating Land/Water/Cloud in AHI data 
 
4a) Now let us move onto the next box over the Southwestern portion of our scene (see 
Figure 8).   Zoom in over the islands in the region (see Figure 9).   
 
Which AHI Band would you use to determine the land/water boundaries?  Why?   
 
How about clouds over land during the day?    
Why are reflectances so different between the visible Band 3 (.64 μm) and Band 4 (.86 μm)? 
 
 
4b)  To help with your analysis, display a Band 3  (.64 μm) image, and create a histogram of 
reflectance values within a sub-region shown in Figure 9 by selecting the “Region” button in 
the top left portion of the display.  Once you click on this button, you can select a series of 
points (appearing as a green “o” in the display) to outline the area of analysis.  To complete 
the polygon, click on or near the first point selected.  The histogram will appear in the “Area 
Probe Graphs” display (see Figure 10, left panel).  You can separate this window from the 
display by Left Click+drag (or Double Clicking) on the window banner.  Once the window is 
standing alone, you can easily resize it.   
 

 
 
Figure 9:  Island sub-region to use for focused examination. 
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Figure 10:  (Left Panel) Histogram of Band 3 (.64 μm) reflectances observed in the region 
outlined in Figure 9, and (Right Panel) the scatter diagram of reflectances in the same region 
between Bands 3 (.64 μm) and Band 4 (.86 μm). 
 
4c)  The Area Probe Graphs window allows you to examine the data in histograms and 
scatter diagrams.  You can change the displayed histogram band (Next to X: layer) by 
selecting it through the dropdown menu.  Compare the histogram of data points in your region 
between Band 3 and Band 4.  What similarities and differences do you see?  Now create a 
scatter diagram of X - Band 3 (.64 μm) versus Y - Band 4 (.86 μm) for our region, by checking 
the box next to “vs Y layer”, and then selecting Band 4 through its dropdown menu (See 
Figure 10, Right Panel).  
  
4d) Examine the scatter diagram.  Answer the questions in the box.  
 
What features in the image cause high reflectances in both bands?   
What features in the image cause Low reflectances in both bands?   
What features in the image cause the reflectances to be different?  
 
Use the Probe, the Layers window values and intensities along with the histograms and 
scatter diagrams to help you.  Get familiar with the Area Probe Graphics options at the top of 
the window that allow you to return to the original display, go forward and back to the displays 
you have been working on, zoom, scroll and save display to disk.  Clicking on the “+” Tab at 
the top of the window allows you to create one or more additional histograms/scatter 
diagrams.   
 
How could using both of these bands together help to discriminate between land/water/cloud 
features?   
How does the higher spatial resolution of band 3 assist in this discrimination?   
 
Once you are finished you can remove the current chosen polygon “Region” by using the 
“Esc” key.  That will also remove anything currently displayed in the Area Probe Graphs 
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window. 
 
Section 5.  Examining Transverse Cirrus Banding in AHI Infrared Bands 
 
5a)  Now let us move north in our region of interest to examine the clouds as shown in  
Figure 11, Right Panel.  Look at the clouds in the infrared bands (Bands 7-16).   
 
What is the main cloud type in this scene?   
How can you tell?   
Examine the clouds carefully in Bands 13-16 (10.4 μm – 13.3 μm) stepping through them one 
by one.  How do the temperatures of the cold clouds change?   
How about the warm clouds?   
 

 
Figure 11:  Left Panel, our region of interest at reduced spatial resolution, and (Right Panel) 
cloudy region at full resolution for focused examinations. 
 
5b)  Now display Band 7 (3.9 μm) brightness temperatures.  Click on this band to highlight it 
in the Layers window. Also Highlight Band 14 (11.2 μm) by using Ctrl+Left Click on this 
Band in the Layers window. You can toggle between just these two bands once they are 
highlighted by using the “V” key.  Toggle back and forth to compare the temperatures and 
features of the clouds.   
 
Which of these bands would you use to view the high clouds?  Low clouds?   
Why are the temperatures of the scene so different?   
Would this be true at night as well? 
 
5c) How could you use the infrared bands to help you determine the height of the clouds?  
Why would knowing that be important for this transverse cirrus banding scene? 
 
 
 
Section 6.  Using AHI to Discriminate Cloud Phase 
 
6a) Now move onto our third sub-region 3 (see Figure 8) over Guam and surrounding waters 
as shown in Figure 12.   Focus on the small region of clouds North of the large cloud mass 
over the islands, and create a histogram of Band 3 (.64 μm) reflectances in the area outlined 
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in Figure 12, Right Panel.  Add a histogram of Band 5 (1.6  μm) reflectances and compare the 
results.  How are they similar; how are they different.  Now create a scatter diagram of Band 3  
(.64 μm) versus Band 5 (1.6 μm).  Identify the region of points on the image where the Band 
3 reflectances are high and the band 5 reflectances are low.   
 
6b) Use the Esc key in the image window to clear the region and histogram.  Look at the 
values and intensities of all the bands in the Layers window as you click in different areas of 
this cloud deck.   
 
Based upon these values can you determine how the bright and dark regions of the Band 5 
(1.6  μm) data can help you determine cloud phase?   
Think of two ways in which this information is important for forecasting, and why having 10-
minute imagery (AHI) or 5-minute imagery (GOES-R) is valuable in monitoring the life cycle of 
a storm? 
 

Figure 12:  Reduced (Left Panel) and full resolution (Right Panel) screen capture of our cloud 
investigation region. 
 
6c) Now lets look at the large cloud deck over the Guam and surrounding waters.  Look at the 
clouds at high resolution.  From what we have learned previously, describe the type and 
phase of clouds observed in this image. 
 
6d) Zoom in to the highest spatial resolution in the visible bands and determine which one 
provides the most detail at the features on the tops of the clouds.  Why is this important?   
 
Kris Bedka  (K.M. Bedka et al., 2010:  “Objective satellite-based overshooting top detection 
using infrared window channel brightness temperature gradients”.  Journal of Applied 
Meteorology, 49. pp. 181-202)  has studied the identification of overshooting thunderstorm 
tops (OTs) from satellite imagery, and has found that OTs were associated with higher 
percentage chances of turbulence and lightning.  The highest chances surround tops that are 
associated with the lowest brightness temperatures in the 11 μm window region.  Using this 
information, where are the most significant risks to aviation in this scene?   
 
6e)  One of the biggest benefits of AHI data is the 10 minute temporal resolution of the 
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imagery.  Load the AHI Band 2 (.51 μm) 10 minute data observed on 18 July 2015 from the C 
drive  /data/ahi/B02 directory between the times of 0100 – 0320 (Figure 13).   Animate the 14 
images.  Note the progression and dissipation of individual thunderstorm cells, outflow 
boundaries and overshooting tops. During this same time period, MTSAT would provide 5 
images at reduced spatial resolution.   
 
Final Lab Question 
 
How will AHI with improved spatial, spectral and temporal resolution affect your ability to 
forecast the weather? 
 

Figure 13:  Choosing AHI Band 2 data files between 0100 and 0320 for display in SIFT 
observed on 18 July 2015. 
 
 
6.  Looking at GOES-16 Data 
 
GOES-16 data are part of this lab now.  Data in this lab are not to be shared anywhere.  Ask the 
instructors if you need clarification on that statement.    
 
 
 
 
 
 
 
 

These GOES-16 ABI data are 
preliminary, non-operational data that 
are still undergoing on-orbit testing. 
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6a:  Severe Convection over Louisiana as viewed by GOES-16 
 

 
Figure 14:  Storm Reports for 2/7/17, and text information for a storm in Orleans Parish (at 1725 UTC) 
 
GOES-16 CONUS data are loaded under the ‘ahi’ folder, but for 2017_02_07 (Convection over New 
Orleans), 2017_02_09 (East Coast Cyclogenesis) and 2017_02_12 (Cold Front/Contrails over the 
southern Plains).  You’ll first be examining the convection over New Orleans.  Enter the 2017_02_07 
folder, then 1729, and load all 16 bands.  Zoom in to the region over New Orleans – the figure below 
shows the ‘Red’ Band – Band 2, 0.64 µm – the one with the best resolution (0.5 km at the sub-satellite 
point).  The probe is located near an overshooting top – can you identify any storm structures that you 
would associate with a tornadic thunderstorm? 
 

 
Figure 15:  SIFT Display of Visible 0.64 µm imagery at 1729 UTC on 07 February 2017 

 
What do you think the Snow/Ice channel would show for this scene?  The Cirrus Channel?  Cycle 
through the different bands – are your assumptions confirmed?  The Snow/Ice channel (Band 5, 1.61 
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µm, with 1-km resolution at the sub-satellite point) is shown below.  Expectations confirmed? 
 

 
Figure 16:  SIFT Display of Snow/Ice 1.61 µm imagery at 1729 UTC on 07 February 2017 

 
It is common for a severe thunderstorm to have a thermal couplet – that is, a very cold region (the 
overshooting top) with a downwind warm trench.  SIFT can be used to interrogate the data.  First, the 

   
Figure 17:  Annotated cloud-top isotherms from GOES-3 Infrared Window data 
 
SIFT data from the New Orleans tornado are shown below (10.3 µm imagery, the ‘clean window’, and 
a region is being constructed around the overshooting top and the downstream warm trench).    Do this 
in your SIFT as well.   Compare the 10.3 µm below (Figure 18) and the 0.64 µm above (Figure 15) – 
are features that are defined in Fig. 17 evident? 

figure at left is from a Monthly Weather Review 
article from 1988 (Heymsfeld and Blackmer) and it 
shows features we can try to identify in the SIFT 
brightness temperature fields over Louisiana.  (The 
Orienta OK tornado whose cloud top features are 
indicated was a strong multi-vortex tornado).   
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Figure 18  a: SIFT Display of Clean Window 10.3 µm imagery at 1729 UTC on 07 February 2017.  A 
region is being defined as shown by the green dots.  b: The completed region is shown below left, and 

c: a bargraph of data values within the region is below right (18c) 
 

                       
 
Figure 18c, above, highlights coldest cloud tops and also points in the warm trench (the red line)…you 
can reproduce this in your SIFT display as well.   
 
    What is the δT between the cold and warm regions?  How does that compare to the figure above 
from 1988?   
 

a 

b 

c 
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Now, zoom back out in this image, and look at the blue (0.47 µm) and red (0.64 µm) and ‘veggie’ 
(0.86 µm) bands over Texas.  Characterize the scenes:   
      Which scene is ‘haziest’?  Which best defines the many lakes of east Texas?  Does this meet with 
what you expect given what you’ve learned about the different channels so far? 
 

Figure 19  SIFT Display of Blue Band 0.47 µm imagery (upper left), of Red Band 0.64 µm imagery 
(upper right) and of Veggie Band 0.86 µm imagery (lower left), all at 1729 UTC on 07 February 2017 

 

 
 

Delete all layers in SIFT.   
 
6b:  GOES-16 views a Cold Front over Texas 
 
Now, load CONUS data from the 2017-02-12 folder – choose one of the four times listed.  I chose 
1457 UTC, and the blue band (0.47 µm) is shown below. 

 
Figure 20  SIFT Display of Blue Band 0.47 µm imagery at 1457 UTC on 12 February 2017 
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Zoom into the region over Texas, and you’ll see something that looks like what is shown in Figure 21, 
below, which figure shows the Red Band.  A Bore feature is clearly indicated.  Bores can be produced 
when one layer of air is forced under a second (stable) layer of air.  Here is the question for this lab: 
 
Which ABI band(s) will not view this feature?     Write your answers here: 
 
 
Now, cycle through the all the ABI Bands.  Were you correct? 
 
 

 
 

Figure 21:  SIFT Display of Red Band 0.64 µm imagery at 1457 UTC on 12 February 2017 
 
Now, look at Band 10 (the lower-level water vapor imagery, 7.3) for this scene, and shift your view up 
to Oklahoma.  You’ll see something like this: 
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Figure 22:  SIFT Display of Lower 
Level Water Vapor 7.3 µm imagery 
at 1457 UTC on 12 February 2017 
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All those contrails in the Water Vapor!  Are you used to seeing contrail features in water vapor imagery? 
 
 
Which ABI Band(s) will not view these contrails?   Write your answer here: 
 
 
Now, cycle through the all the ABI Bands.  Were you correct? 
 
Delete all layers in SIFT. 
 
6c:  GOES-16 views cyclogenesis and mountain waves 
 
GOES-16 viewed one of the many early February north-easters on 9 February 2016.  Enter the “2017-
02-09” folder and load the animation of Band 10 data – choose data from the ‘b10’ folder.  Turn the 
animation on and off (using either the ‘a’ key, or the big arrow beneath the SIFT display).  Adjust the 
playback speed by right-clicking on the arrow.  This animation is one I can watch for a long time, it’s 
beautiful.  Which features of cyclogenesis are evident off/near the East Coast of the United States?  
Can you identify Warm and Cold Conveyor Belts?  A Hammerhead Dry Slot?  Apart from mountains, 
can you see surface features?   Do you expect to see surface features in Water Vapor imagery?  Why or 
why not? 
 
Note that the data are ‘only’ hourly here!  I could have included 12x the data – every 5 minutes – in this 
CONUS domain! 
 

 
Figure 23:  SIFT Display of Lower Level Water Vapor 7.3 µm imagery at 1400 UTC (Left), over the 

Appalachians, and at 0700 UTC (Right) over the Rockies, both from 9 February 2017 
 
 
On your whiteboard, write one thing in this animation that strikes you as something that would 
not be visible from current GOES. 
 
Delete all layers and exit SIFT. 
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